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CHAPTER 1

Getting Started

The Identify® Microsemi® Edition tool set includes a software instrumentor
and a hardware debugger. The combination of these two tools lets you debug
your HDL design:

¢ In the target system,
e At the target speed,
* At the VHDL/Verilog RTL Source level.

The Identify tools enable the debugging of FPGA designs, FPGA-based proto-
types, and system-on-a-chip designs. For the first time, you can debug live
hardware using intuitive, HDL-based debugging techniques that provide
visibility into the internal operation of your system.

The Identify software easily integrates into your existing design flow so that
minimal effort is required to begin the debugging of your HDL designs. To
better understand how the Identify instrumentor and debugger work and how
they function within your HDL design flow, this guide provides comprehen-
sive information about navigating through the Identify tools and integrating
with your other design flow tools.

This remainder of this chapter describes:
¢ The Debugging System
* Design Flow

e Tutorial Requirements

Identify for Microsemi Edition Tutorial © 2014 Synopsys, Inc.
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Getting Started The Debugging System

The Debugging System

The Identify concept is based on the principle of in-system debugging. Using
the Identify tool set allows you to debug your device in the target system, at
target speed while still debugging at the HDL level.

The Identify instrumentor captures your device’s internal states by inserting
probe hardware (called an IICE™ - Intelligent In-Circuit-Emulator) into your
design. The IICE captures internal design states based on user-specified
trigger conditions. Data captured at the target device is transferred back to
the host computer where it is transformed and displayed by the Identify
debugger.

Your System

Your
Device

The Identify tool set is a dual-component software system consisting of:
¢ an Identify instrumentor which inserts and configures the I[ICE

¢ an Identify debugger which controls the I[ICE and displays data from the
IICE

The following sections briefly describe these components.

© 2014 Synopsys, Inc. Identify for Microsemi Edition Tutorial
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The Debugging System Getting Started

Identify Instrumentor

The Identify instrumentor reads and analyzes the HDL description of a design
and provides you with detailed information about the signals that can be
sampled and the locations in the source code where breakpoints can be set.
This information is collectively referred to as the instrumentation.

[ICE Block

The Identify instrumentor uses the HDL design files and your selected instru-
mentation information to create the custom IICE. An IICE block is logic that
probes the design and communicates with the Identify user interface through
the device JTAG port. The IICE is implemented using the logic resources of
the device. The Identify instrumentor defines one or more IICE blocks in the

design netlist with the modifications necessary to implement and intercon-
nect the IICE blocks.

Identify Debugger

The Identify debugger lets you interact with your real hardware at the HDL
level. In the Identify debugger, you set trigger conditions to determine when
to capture data, and then view the captured data as either annotated source
code or as waveforms.

Identify for Microsemi Edition Tutorial © 2014 Synopsys, Inc.
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Getting Started Design Flow

Design Flow

Design flows for HDL design and debugging vary according to the type of
hardware and device you use. Displayed below is the typical HDL design flow
without the Identify tool set on the left and a typical HDL design flow with the
Identify tool set on the right.

Write HDL
Write HDL Instrument
Synthesis Synthesis
Place Place
and and
Route ROthe
Program Plgog_ram
Device evice

Design Flow without ¢
Identify Tool set Debug

Design Flow with
Identify Tool Set

In the design flow without the Identify tool set, the first step is to create the
HDL source files for the design. Next, the design is synthesized to the target
device. Once synthesized, the design is placed and routed before it is finally
implemented in the target device.

© 2014 Synopsys, Inc. Identify for Microsemi Edition Tutorial
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Tutorial Requirements Getting Started

The design flow with the Identify tool set adds two steps to the standard flow
— one step at the beginning and one step at the end. After the HDL source is
created, the Identify instrumentor is used to create a debuggable design. This
design is then run through the rest of the standard design flow. After the
instrumented design has been implemented in the device, the Identify
debugger is then used to debug the design in the target system.

Tutorial Requirements

This tutorial guides you through the process of debugging a small HDL
design in a real hardware environment. The tutorial teaches you how to
generate an instrumented design for debugging and then how to debug that
instrumented design.

The tutorial explains how the Identify tools are used in concert with your
synthesis and place-and-route flow. However, the tutorial does not provide
details and procedures for synthesizing and using place-and-route tools with
your instrumented hardware design. For the purposes of this tutorial, it is
assumed that you have a working implementation flow. To find out more
about these processes, consult your synthesis documentation and vendor
place-and-route tool documentation for more information.

Hardware/Software Environments

This tutorial is performed with Microsemi hardware. The tutorial was devel-
oped using the following software:

* Identify tool set: Identify H-2012.12M or later
* FPGA synthesis software: Synplify Pro G-2012.09-SP1M or later

Note: Other device families and devices, and board systems can be
used.

Identify for Microsemi Edition Tutorial © 2014 Synopsys, Inc.
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Getting Started Tutorial Requirements
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CHAPTER 2

The Tutorial Design

SYNOPSYs

2rating Innovation

The Identify tool set can debug a variety of HDL designs. To better under-
stand the debugging process, this guide provides a small HDL design
example. The example design is a simple bus demo circuit. The HDL source is
written in VHDL and is based on the open-source Wishbone bus. A block

diagram of the design is shown below.

Traffic Traffic
Generator Generator
Word Block
Transfer Transfer
Master Master
ROM RAM1 RAM 2

Identify for Microsemi Edition Tutorial
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The Tutorial Design

The design contains two bus masters connected to three slave devices. The
bus masters are the Word Transfer Master and the Block Transfer Master. The
slaves are the three memory devices, ROM, RAM1, and RAM2. The bus
masters are driven by traffic generators that request random bus transac-
tions. The arbiter controls master access to prevent bus conflicts. The arbiter
monitors bus requests, and grants bus accesses based on a fair algorithm.

The arbiter uses two clocks. One clock is used by the state machine and the
other is used by the other logic modules and also to synchronize with the
state-machine clock. The two clocks are used to demonstrate cross-triggering
as explained later in this tutorial. The focus of the tutorial is on the arbiter

and a 4-bit counter.

For the tutorial, you will instrument the design for an IGLOO PLUS device.
You will then debug the design hardware to gain a basic understanding of the
Identify tool set and how it integrates into your synthesis environment.

Note: Other supported Microsemi device families and devices can be

used.

Design Schematic

The following figure is a schematic representation of the simple bus circuit
used for the tutorial design.

—@ L=

e

o8

1-DCM

2 - Arbiter

3 - Word Transfer Controller
4 - Word Transfer Logic
5-RAM 2

© 2014 Synopsys, Inc.
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6 - ROM =7
7-RAM 1

8 - Block Transfer Controller
9 - Block Transfer Logic
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The Tutorial Design

VHDL Design Files

The bus demo design used for this tutorial is implemented in VHDL. The
initial VHDL design files, as loaded into Synplify Pro, are shown in the figure
below:

|MiC|'DSEI'ni IGLOO+ : AGLPO30V2 : C5201 : 5td

=@ [identify_bus_dema] - C:\designs\identify_bus_demo

= [£# vHOL
- /g arb.vhd [work]

- g blk_xfer_cntrl.vhd [wark]

- block_xfer.vhd [work]

- 4 bus_dema.vhd [work]

- 1 Ifsr.vhd [work]

- 1 ram_impl.vhd [work]

- 1 rom_impl.vhd [wark]

- 1 wh_ram.vhd [wark]

- 1 wh_rom.vhd [wark]

- 5 word_xfer.vhd [work]

- 1 word_xfer_cntrl.vhd [work]

ﬁ irev 1

Board Clock Configuration

As previously mentioned, this tutorial was developed using a Microsemi
IGLOO PLUS device (AGLPO30V2). The bus_demo.vhd file in the tutorial design
uses a 50 MHz clock (clk) and a 33 MHz clock (clk_arb) clocks for the design.
These frequencies are set by define_clock constraints in the constraint file
provided with the tutorial.

Identify for Microsemi Edition Tutorial © 2014 Synopsys, Inc.
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The Tutorial Design
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CHAPTER 3

Instrumenting Your Design

The Identify instrumentor selects the design visibility (breakpoints and
watchpoints) and special hardware configurations including complex event
counters, and sampling and triggering modes for your design. The goal of the
instrumentation process is to define an IICE and insert it into your HDL
design. The instrumentation flow is:

¢ Launching the Identify Instrumentor
¢ Selecting the Instrumentation
* Configuring the IICE

* Writing the Instrumented Design

The HDL design files for the tutorial are included in a tar or zip file in the
share subdirectory within the installation directory. Unpack the appropriate
file to a local directory and make sure that you have read and write permis-
sion for both the directory and files.

Launching the Identify Instrumentor

The Identify instrumentor is launched directly from the Synplify Pro
synthesis tool.

Identify for Microsemi Edition Tutorial © 2014 Synopsys, Inc.
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Instrumenting Your Design

Launching the Identify Instrumentor

Creating a Synplify Project

Before you can launch the Identify instrumentor, you must create the project

in Synplify Pro. To create a project:
1.

2.

Start the Synplify Pro synthesis tool.

Select the Open Project button (just below the large Run button) and click

New Project in the dialog box.

Click File->Save As from the top menu bar and navigate to the directory
where you downloaded the design files. Enter identify_bus_demo.prj as the

project name and click Save.

. Click the Add File button to display the Add Files to Project dialog box. In the

dialog box, click <-Add All to select all of the HDL files and then click OK
to add the selected files to the project and close the dialog box. If the list
of files is not displayed in the dialog box, make sure that Files of type field

is set to HDL Files (or All Files).

Expand the VHDL (shown) or Verilog folder by clicking on the “+” to the
right of the folder to display the list of design files as show below.

E}--.Jéljdentiﬁt bus demo] - C:\designs\tutorialydentify bus_demo.prj

5

g

© 2014 Synopsys, Inc.
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WHDL
H arb.vhd [work]

- blk_xfer_cntrl.vhd [work]
 H block_xfervhd [work]

- ] bus_demo.vhd [work]

- [H Ifsr.vhd [work]

-+ g ram_impl.vhd [work]

- rom_impl.vhd [work]

- H wh_ram.vhd [work]

- H wh_rom.vhd [work]

- H word_xfer.vhd [work]

- [ word_xfer_cntrl.vhd [work]

Logic Constraints (SDC)
rev_1

Identify for Microsemi Edition Tutorial
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Launching the Identify Instrumentor Instrumenting Your Design

6. From the top menu bar, select Project->Implementation Options and, if
necessary, select the Device tab. Set the technology in the Technology
drop-down menu to Microsemi IGLOO+ and set the device in the adjacent
Part drop-down menu to AGLP0O30V2.

Device
Technology: Part: Package:
Microsemi IGLOO + v | Lacnozova ~| |cs201
{ ——
Device Mapping Options
AGLPOBOVZ
Ot AGLPOBOVS
pron AGLP125v2
Fanout Guide AGLP125VW5

Disable 10 Insertion

Update Compile Point Timing Data
Promote Global Buffer Threshold

Guide for fanout-based optimizations (such as replication)

7. Without closing the Implementation Options dialog box, select the
Implementation Results tab and make sure that the Result Base Name is
bus_demo and that the Result Format is edif (the only selection).

Implementation Results

Implementation Name:
[ rev_2 ]

Results Directory:
[C: \designs\identify_bus_dema'rev_2 ” Browse... |

Re Baze Mame: Result Format:

c=;

8. Select the VHDL tab and enter work.bus_demo in the Top Level Entity field.
Note that it is recommended for the top-level VHDL entity to be in the
work library.

Identify for Microsemi Edition Tutorial © 2014 Synopsys, Inc.
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Instrumenting Your Design Launching the Identify Instrumentor

VHDL

Top Level Entity: Default Enum Encoding:

Push Tristates

[] synthesis On/off Implemented as Translate OnfOff
[] vHOL 2008

[ Implicit Initial Value Suppart

9. Click OK to close the Implementation Options dialog box.

Launching the Instrumentor

After creating a project in Synplify Pro, you are ready to launch the Identify
instrumentor directly from your synthesis project. To launch the Identify
instrumentor:

1. Right click on the rev_1 implementation in the project view and select
New Identify Implementation from the popup menu.

ProjectFiles | Design Hierarchy | Imentation Directory
|Mi|:rosemi IGLOO+ : AGLPO30V2 : C5201 : 5td C:\designs\identify.
=- & [identify_bus_demo] - C:\designs\dentify_bus_demolidentify_bus_demo.prj Name
E IM'HDL backup
"""" L ;
Implementation Options. .. a coreip
Change Implementation MName... : ﬁ syniog
&) syntmp
Hierarchical Project Options, .. ﬁ synwark

Add Subproject Implementations

Copy Implementation. ..
Remove Implementation. .. DEL
New Identify Implementation...
# Launch Identify Instrumentor %
ﬁ} Launch Identify Debugger

2. When you select New Identify Implementation, you are presented with the
Add Identify Implementation dialog box. This dialog box is identical to the
Implementation Options dialog box that you used when setting up your
project. Unless you have any additional changes (unnecessary for the
tutorial), click OK to close the dialog box.

© 2014 Synopsys, Inc. Identify for Microsemi Edition Tutorial
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Launching the Identify Instrumentor Instrumenting Your Design

3. When you close the dialog box, an Identify implementation is added to
the project as noted by the icon with the magnifying glass.

Project Files )
|Microsemi IGLOO+ : AGLPO30V2 : C5201 : 5td
=- @ [identify_bus_demo] - C:\designs\identify_bus_dema'identify_bus_demo.prj
[ vHOL
: rev_1
# rev_2

4. Right click on the Identify implementation and select Launch Identify
Instrumentor from the popup menu.

Project Files | Design Hierarchy | Project Status | Implement
[Microsemi IGLOO+ : AGLPO30V2 : C5201 : Std [ Cr\designs\identify_bus_der
EI‘] [identify_bus_demo] - C:\designsYdentify_bus_demaoVidentify_bus_demo.prj |Name
VHOL backu
:::—; e coreipl:l
""""""""" Implementation Options... % :y;lhof
Change Implementation Name. .. @ s:nw;k

Hierarchical Project Options. ..

Add Subproject Implementations

F

|

Copy Implementation. ..
Remove Implementation. .. DEL
MNew Identify Implementation...

# Launch Identify Instrumentor

ﬁ} Launch Identify Debugger %

If the synthesis tool detects more than one copy of Identify or if the path
to the Identify executable has not been established, the following dialog
box appears.

Identify for Microsemi Edition Tutorial © 2014 Synopsys, Inc.
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Instrumenting Your Design Launching the Identify Instrumentor

Configure Identify Launch 21x1

~Locate Identify

() Use Current Identify Installation

[ i \tools\identify_F2010095P1 |

@ Locate Identify Installation (identify_instrumentor)

[C:\tools\ldenﬁfy_EZD:ll.DB ] m

—Identify License Option

() Use current synthesis license

‘® Use separate Identify license

| Ok || Cancel |

Click to select the executable currently displayed or click the Locate
Identify Installation radio button, navigate to the Identify installation direc-

tory, and click OK.

S. You are next prompted to save the changes to your synthesis tool.

Project changes must be saved before launching Identify.

Is it OK to save the project ?

/N [ o |[ concs |

Click OK to save the project and to launch the Identify instrumentor.

© 2014 Synopsys, Inc. Identify for Microsemi Edition Tutorial
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Launching the Identify Instrumentor Instrumenting Your Design

Launching the Identify instrumentor from the Synplify Pro synthesis tool:

* Brings up the Identify instrumentor graphical interface.

Note: If you are prompted to select a license type, select the appro-
priate type from the list; check the Save as default license type box
to avoid the license prompt in future sessions.

* Opens the synthesis project (prj) file in the Identify instrumentor. The
list of design files, their work directories, and the device family are
automatically extracted from this prj file.

¢ Automatically compiles the design files in the specified technology
(IGLOO+) using the Synplify Pro compiler.

* Displays the design hierarchy and the HDL file content with the poten-
tial watchpoints and breakpoints identified for selection.

Identify for Microsemi Edition Tutorial © 2014 Synopsys, Inc.
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Instrumenting Your Design Selecting the Instrumentation

Selecting the Instrumentation

After your VHDL design compiles, the instrumentation window displays the
top-level entity VHDL code on the right and the hierarchy browser on the left
(if the instrumentation window is not displayed, click on the “IICE” tab at the
bottom of the project window). The tutorial uses the hierarchy browser to
navigate through your design. Clicking on a hierarchical node updates the
corresponding section of code in the source code display on the right.

Identify Instrumentor - [C:/designs/identify_bus_demo/identify_bus_demo] - |EI|1|
File Edit Actions Options Help

Lol — A

, ROOT [bus_dema) ;I 32 entity bus demo is ;I
& teh 3 generic |
data_width : positive := 8;
addr_width : positive := 10; J

[¥]

slave addr size: positive :=

)z

port |
39 dfclk in : in  std_logic;
- clk arb : in std logics
41 éda_dl’_g : out std logic vector (addr_width-1 downto 0):
42 tﬁ:{M i out std logic_vector (data_width-1 downto 0)

)z

14 end bus_demo;

16 architecture beh of bus_demo is

0 || o

Instrumenting the Arbiter

To instrument the arbiter:

1. Expand the beh block in the hierarchy browser by clicking on the “+’ sign
adjacent to the block.

© 2014 Synopsys, Inc. Identify for Microsemi Edition Tutorial
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Selecting the Instrumentation

Instrumenting Your Design

2. In the expanded hierarchy, click on arb_inst (arbiter) to update the
instrumentation window with the arbiter entity beginning on line 32.

- beh

B word_wfer_ingt [word_xfer] 33

B word_=fer_catilinzt [word_sfer_cntrl]

@ blk_sfer_inst (block_xfer] ]

L=t hlk wfer cnbil inst [hlk_=fer cibrl] =
arb,_| biter)

rarn_inst Wb :

f— ram1_ingt [whb_ram1] -

ramz2_inzt [wh_ramz) o

H—ig U1 [ibufg) i

t— @ doml [dom)] i

t— @ cll_bufl_fx (bufg) 40

]_

]_

]_

clk_bufd [bufg)
dom [dem) i
clk_bufl [bufg) 4z

=76 RODT fus_demo =] 32 entity

41 end arbiter;

arbiter i=

in ztd logic;
in ztd logic;
in ztd logic;

in ztd logic;

gograntl : out std logic;
gogrant? : out std logic

3. With the arbiter still displayed, click on the clk signal on line 34 (or the
adjacent eyeglass icon) to display the watchpoint menu.

32 entity arbiter is

33 port |

34 ool : in etd lomic:
Sample and trigger

35 ffres P - ic;
Sample only

36 dfrec  Trigger only ic;

37 o rec ¥ Motinstumented ic:

Sample C

39 dogra.  Addmus group .. cic

41 end arbiter;

4. In the watchpoint menu, click Sample Clock. The eyeglass icon is replaced
with the sample clock icon to indicate that the clk signal is now defined

as the sample clock for the IICE.

32 entity arbiter is

33 port |

34 Gﬁ tin std logic:
35 goreset : in std logic;
36 dreql : in std logic;
37 direql? : in std logic;

Identify for Microsemi Edition Tutorial
November 2014
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Instrumenting Your Design Selecting the Instrumentation

S. Locate the first occurrence of the curr_state signal on line 46 in the source
code display. Select this signal for instrumentation by clicking on the
signal name (or the adjacent eyeglass icon) and then selecting Sample and
Trigger from the popup menu. The eyeglass icons preceding each
occurrence of the curr_state signal in the VHDL code for the arbiter will be
green.

When you select a watchpoint instrumentation type from the popup
menu, the icon lenses change color according to the type selected as
outlined in the following table.

Icon Color Watchpoint Selection
Green Sample and trigger
Blue Sample only
Red Trigger only

Clear (unfilled) Not instrumented

The command that you would enter manually or in a shell script to
define the watchpoint signal (signals add -sample -trigger -iice IICE
/beh/arb_inst/beh/curr_state) and the cumulative instrumentation to imple-
ment the watchpoint are displayed in the console window.

6. To become familiar with the command-line interface, use the console
window to set a sample and trigger watchpoint on the next_state signal.
At the command prompt, enter:

signals add -sanple -trigger -iice Il CE
/ beh/ arb_inst/beh/ next _state

Check that the eyeglass icon preceding the next_state signal on line 46 is
green (sample and trigger).

7. Again using the graphical interface, locate signal grantl on line 39 and
set its watchpoint to Sample Only. The icon lenses are blue for Sample Only.

8. Locate signal grant2 on line 40 and set its watchpoint to Trigger Only. The
icon lenses are red for Trigger Only.

© 2014 Synopsys, Inc. Identify for Microsemi Edition Tutorial
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Selecting the Instrumentation Instrumenting Your Design

The following figure shows the resulting assigned watchpoints.

32 entity arbiter is

port |
34 Gﬁ tin std logic:
35 $oclk_svys : in std logic;
36 direset : in std logic;
37 gzl : in std logic;
38 dr2 : in std logic;

gwgrantl : out std logic;
a0 #wgrant? : out std logic
41 )i
42 end arbiter;
44 architecture beh of arbiter i=
45 type states is ( st_idlel, st idle2, =t _grantl, st_grantl):

46 zignal dwourr state, dWDEXC STate: sStates;

Assigning Watchpoints to a Partial Bus

This section shows you how to instrument a partial bus. The section uses the
blk_xfer_inst (block_xfer) entity from the tutorial design to illustrate watchpoint
assignment. To instrument the partial bus:

1. In the hierarchy browser, click on blk_xfer_inst (block_xfer) to update the
instrumentation window with the block_xfer entity.

2. Click on the wb_adr_o bus on line 35 and use the popup menu to select
Add partial instrumentation.

3. In the dialog box displayed, enter 7 for the MSB value, enter 5 for the
LSB value, and select Sample Only from the drop-down menu for the
instrumentation type.

Identify Instrumentor: Add partial inst |

Inztrument partial slice of zsignal: 'Ybehd/blk_sfer_inst/wb_adr_o' [10 bit]

15B: I?’ LSEB: |5 |Samp|e Only |'|
ak. I Cancel |
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4. Click OK. The eyeglass icon is replaced with a large P symbol to indicate
a partially assigned bus. The symbol is blue to indicate sample only;
other sample options are designated by other colors.

28 entity block xfer is=s

29 generic |

30 data width: positcive := &;

31 slave addr size: positive (= 2;

32 addr width: positive := 10

33 )i

34 port |

35 [wa adr o: out =td logic wector (addr width-1 downto 0) (= [ other
36 fowh dat i: in ztd logic wector (data widch-1 downto 0) = [ others
- P

Note: A single bit of a bus can be instrumented by designating it as
both the LSB and the MSB.

5. Again click on the wb_adr_o bus and note that the previous bit selection
is displayed and that you can change the instrumentation options for
that selection.

34 port |

35 I?fﬂ-b adr or st =rA Jamis trasrae (sdde wridrh_i = ( others
wh adra 7 5 Sample and trigger

36 fowk dat i —— E = = | others
Add partial instrumentation v Sample only

3 dowk_dat_c parialr faten - Trigger only = | others

38 ddwb_cve o: out std laogic: Mot instrumented

32 dowb_ack i: in std logic := '0';

6. Select Add partial instrumentation and, in the dialog box, set MSB to 3, set
LSB to 2, and leave the instrumentation options set to Sample and trigger.
Click OK and note that the color of the P icon changes to yellow to
indicate mixed instrumentation types (Sample only and Sample and trigger).

7. Click on the bus to see both partial instrumentations. Either can be
changed from one type to another (or “not instrumented”) using the
popup menu.
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34 port |

35 Puwb_adr cr ror =rd lomis samesw (gddr width-1 dow = ( others

. St dat 3 wh adi_o 7 5 4 o D) ( on:

36 o] at i p— ) o = others =
—_— wh adr o 32 4 v Sample and trigger

37 vk _dat_c — i Sample anly OWRLO i= [ others

Add partial instrurmentation .. .
38 dub_cyeo o= o Trigger only
33 vk ack i: in std logic := '0" Mei e amertzs

Assigning Breakpoints

Breakpoints are used to trigger on reaching a branch in the code rather than
triggering on a logic-level transition. For this portion of the tutorial, the
arbiter entity is again used to illustrate breakpoint assignment. To assign
breakpoints:

1. Again click on arb_inst (arbiter) in the hierarchy browser to update the
instrumentation window with the arbiter entity.

2. In the source code display, scroll down to the case statement beginning
on line 88. Click on the first five breakpoint buttons in the left margin on
lines 90, 91, 93, 95, and 97. The buttons change from clear to green to
indicate that they are active.

B8 case [(dfcurr state) is

29 when st _idlel =>

@ 90 if | dfregll = '1' ) and | ¢ffreg2z = '1' ) then
@ a1 éenext_state <= st_grantl;

92 el=sif [ dfregll = '1' ) then
-] 93 éenext_state <= st_grantl;

94 elsif | ég’regzz = '1'" )} then

@ a5 éenext_state <= st_grantl;
96 else

@ a7 éenext_state <= st_idlel;
o8 end if;

Similar to the watchpoint selection, the Identify instrumentor displays the
commands that you would enter manually or in a shell script to define the
breakpoints.
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Configuring the IICE

The IICE settings common to all IICE units for an instrumentation are set in
the project window, and the individual IICE settings unique to each IICE in a
multi-IICE configuration are set on the IICE Configuration dialog box.

Setting the Common |ICE Parameters

The common IICE parameters are set in the project window. To redisplay the
project window, click the project window tab (identify_bus_demo) in the lower
left corner of the instrumentation window.

32 fogclk in : in std logic:
4 - =1k arb in =std logic;
41 foadr o : out =std logic vector
42 godat o : out =std logic vector
- s
.
< I Y | <1
[ bus_demn_xling” IICE
Project window tab Instrumentation window tab

The common IICE parameters appear in the Implementation Options block on the
right side of the project window.

Identify Instrumentor - [C:/designs/identify_bus_demeo fidentify_bus_demo*] = | [m] | il

File Edit Actions Options Help

—
Open Project | @ident@,busﬁdemo" - Instrumentation Optians for rey_2" N
—~ 2 vhd
b

Device family: igloopluz

MNew lICE |
Communication port; builtin j

[ Use skew resistant hardware )

I | Frepare increments

— Compile Option:

Top level unit: wark.bus_demo

For the tutorial design:
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Instrumenting Your Design

* The device family (iglooplus) is specified in the synthesis tool and reported
in the Device family field from the -technology entry in the project file.

* Communication between the Identify debugger and the hardware is
specified by the JTAG port field. For the tutorial, make sure that builtin is

specified.

¢ Leave the Use skew resistant hardware check box unchecked.

Setting the Individual IICE Parameters

The individual IICE parameters are set by tabs on the IICE Configuration
@ dialog box. Click on the Edit ICE settings icon on the toolbar or select

Actions->Configure IICE from the menu to bring up the IICE Sampler tab

shown in the following figure.

IICE Sampler |

Current [ICE: IIIEIE j IICE type: |regu|ar

—IICE Sampler

Buffer tupe:

I internal_memony

[

[ Allow qualified sampling
[ Allow always-armed tiggering

[ Allow data compression

Sample depth ( oo )

-
>l

— Sample Clock
Sanple clock: |.-"b8h.-"alb_in8l.-"c|k
Clock edge: {* Positive © Megative

The IICE Sampler tab defines the current IICE unit, buffer type, sample depth
of the data sampling hardware, controls the three optional sampling modes,

and defines the sample clock and clock edge.

For the tutorial design:

Identify for Microsemi Edition Tutorial
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¢ Leave the Buffer type set to internal_memory (only available selection).
* Set the Sample depth to 4096 (use the up/down arrows).

* Leave the Allow qualified sampling check box unchecked.

¢ Leave the Allow always-armed sampling check box unchecked.

¢ Leave the Allow data compression check box unchecked.

¢ Make sure that the Sample clock specifies /beh/arb_inst/clk and that Positive
is selected for Clock edge. Note that the sample clock was instrumented
at the beginning of the tutorial; to change the clock edge, you must use
the IICE Sampler tab.

After you have set and/or verified the above IICE Sampler tab settings, click the
IICE Controller tab.

IICE Contrller |

Current [ICE:  |IICE j IICE type: |regulal
— IICE Contraller

" Simple tiggering

' Complex counter tiggering

Wit [16 2
" State Machine tiggering
Trigaer, states: |4 §||
Trigaen camditions: |1 §||
Courter width: |1E §||
— ICE Optiohs
Import external trigger signals: |D ﬂ

[~ Export IICE tigger sighal

[ Allavs cross-tiggering in [IEE

On the IICE Controller tab:

¢ Make sure that the Complex counter triggering radio button is selected and
that the Width is set to 16.
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* Leave the Import external trigger signals field set to O (disabled).
* Leave the Export IICE trigger signal check box unchecked.

e The Allow cross-triggering in lICE selection is currently disabled (grayed-out);
this selection will be enabled when a second IICE unit is added as
described in the next section.

When all of the IICE configuration settings have been made or verified, click
the OK button at the bottom of the dialog box.

Creating a Second IICE

A second IICE unit is used with the tutorial to create a trigger event to illus-
trate cross triggering. Identify supports multiple instances of IICE units to
allow multiple instrumentations of a design to exist concurrently. The
individual instrumentations do not interfere with one another and support
triggering in different clock domains. To create a second IICE unit:

1. Redisplay the project window by clicking the project window tab
(identify_bus_demo) in the lower left corner of the instrumentation window.

2. Click the New IICE button to add the second IICE unit (ICE_0). When you
click the button, the instrumentation window is redisplayed with the
second IICE tab (IICE_0) active and with all of the watchpoints and
breakpoints unselected.

3. Expand the beh block in the hierarchy browser by clicking on the “+’ sign
adjacent to the block and click blk_xfer_inst (block_xfer).

4. Instrument the wb_clk_i signal on line 43 as the sample clock.
S. Instrument the wb_cyc_o signal on line 38 for sample and trigger.

6. Click the Edit [ICE settings icon in the toolbar to open the Configure IICE
parameters dialog box.

7. On the IICE Sampler tab, make sure that the Sample depth is set to 128.
Note that the Current lICE field reports IICE_0 and that the sample clock is
/beh/blk_xfer_inst/wb_clk_i.
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Configuring the IICE

IICE Sampler |
EurrentIICE‘ IIICE_D ’ j IICE type: |regu|ar
—IICE Sampler
Buffer tupe: Iintemal_memnl_l,l j
Sample depth: j‘

[ Allow qualified sampling
[ Allow always-armed tiggering

[ Allow data compression

— Sample Clock
N\
Sanple clock: G.f'beha’blk_:-tfer_insta’wb_clk_i )
Clock edge: {* Positive © Megative

8. Select the IICE Controller tab and make sure that the Simple triggering radio

button is selected.

9. Make sure that the Allow cross-triggering in lICE check box is not checked

and then click OK to close both tabs.
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Writing the Instrumented Design

from the menu or click on the Save project’s activated instrumentation icon

on the toolbar. Saving the project automatically adds a set of files to

the Identify implementation directory (rev_2). These files are subse-
quently used by the Synplify Pro synthesis tool to insert the instrumented
logic into the design netlist.

a To write the instrumented design, select File->Save project instrumentation

The information at the bottom of the display reports the total number of
instrumented signals to implement in each IICE. To display the FPGA
resource estimates for the selected IICE unit, click the [ICEs resource estimation
icon.

Identify Instrumentor - [C:/designs/Designs7_certify [large_design_g201209 verplex_design]

File Edit Actions Options Help
=B e k| )
I~
I'F

\\M\:HTCES reource estirnationbé

After several seconds, an estimate of the additional resource requirements is
reported at the bottom of the display.

C:/designs/identify bus_demof device estimate -resources -iice IICE O
INFC: device estimate -resources —iice IICE O
IICE=IICE O
Besources estimated: 0 BRams, 477 CoreCells

The tutorial implements a small design on a large FPGA, and the additional
IICE resources are not an issue. Implementing designs that approach the
capacity of an FPGA can limit the amount of instrumentation logic (watch-
points and breakpoints) that can be included.

For the tutorial, the IICE is configured to use the built-in communications
mode. If you had selected the soft JTAG port setting, four extra ports (three
input and one output) would have been added to your design. If this was the
case, you would have to provide access to these ports on your board to
connect the JTAG communication cable to these ports (see the User Guide for
more information).

This concludes the instrumentation phase of the tutorial. You can now close
the Identify instrumentor.
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CHAPTER 4

Implementing the Design

At this time, you should have successfully completed the instrumentation of
the tutorial design and saved the instrumented project.

Implementing the design involves the following steps:
* Synthesizing the instrumented VHDL or Verilog
* Placing and routing the design to produce a bit file

* Programming the device with the bit file

Synthesis translates the instrumented VHDL or Verilog code to a mapped
netlist. Place-and-route tools further process this EDIF netlist to create the
implementation of the instrumented design.

Synthesis

The Identify Microsemi Edition tool set is explicitly designed to work with the
Synplify Pro synthesis tool. When you save the activated instrumentation for
your project at the end of the instrumentation phase, several new files are
created. These files include:

* identify.idc — this file is created in the implementation (rev_2) directory and
describes instrumentation design constraints. In the synthesis tool, the
pre-mapper reads the constraints from this file to insert the instrumen-
tation logic into the design
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¢ syn_dics.cdc — this file is created in the instr_sources subdirectory in the
implementation directory and consists of compiler design constraints
specific to the instrumentation. At the start of compilation in the
synthesis tool, the compiler reads the constraints and adds the appro-
priate hyper-source attributes to the gate-level netlist file.

¢ syn_dics.sdc — this file is created in the instr_sources subdirectory in the
implementation directory and includes the timing constraints for the
instrumentation logic.

¢ 1ICE_mdic2signal.txt and IICE_0_mdic2signal.txt — these text files are created
in the top (identify_bus_demo) directory and describe register links for the
instrumented signals for each IICE.

Unlike previous Identify releases, the instrumented logic is not inserted into
the RTL netlist and is only visible in the gate-level netlist.

Synthesizing the Bus Demo Design
To synthesize the instrumented bus-demo design:

1. In the project view, right click on the identify implementation (rev_2) and
select Add Place & Route from the popup menu to display the Add New Place
& Route Task dialog box.

2. In the dialog box, make sure that Run Place & Route after synthesis is
checked and click OK
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i Add New Place & Route Task e |

Place & Route Implementation:

pr_il

—Flow Settings

”
\_[+] Run Place &Route after Synmesis)

~Place & Route Options File:

Standard Options File

Add Place & Route Options File

Existing Options File. .. | | Create New Options File... |

| OK | | Cancel |

3. In the project view, make sure that pr_1 - Actel P&R is checked in the
Identify implementation. The following figure shows the final project
view with the added file.

Project Files |
|Microsen1i IGLOC+ @ AGLPO30V2 : C5201 @ Std
=@ [identify_bus dema] - C:\designsYdentify_bus_demo\identify_bus_demo.pri
g VHEL
> rev_1
= rev 2
;ﬁ] pr_1 - Actel PER )

4. Click the Run button or select Run->Run from the menu bar to synthesize
the tutorial design. When prompted to save the changes to your project,
click Yes.

When synthesis is complete, you can view the inserted comm and IICE blocks
in the Technology (srm) view.
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syn_hyper_conned_sl

ident|hyperc_vb_dk_i_0

IICE_D
— yn_hyper_conned_sl

- IICE_0
IicE ident_hyper; wb_cyc_o_IICE_0_1 —
IICE_0_INST

comm_block

T+

— - comm_block e

comm_block_INST

licq

IICE_INST

11CE_0_iiceZeamm{0:1]

Place and Route

After synthesis, run the resulting (EDIF) netlist file generated by the Synplify
Pro synthesis tool through the Libero place and route tool. Running the file of
the instrumented design through place and route is identical to running
place and route on the original design. Refer to your place and route tool
documentation for further information.

If you selected the soft JTAG port setting, four external ports are added to the
tutorial design. These ports are:

e identify_jtag tdi (input serial data IN signal.)

e identify_jtag tck (input asynchronous clock signal)
e identify_jtag_tms (input control signal)

e identify_jtag tdo (output serial data OUT signal.)

You must provide proper pin locations for these ports to your place and route
tools. These pins must be connected to your JTAG cable to enable communi-
cation with the Identify debugger. Please refer to the user guide for more
information about this process.
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Program the Device

Programming the target device with the bit file of the instrumented design is
identical to programming the target device with the original design’s bit file.
Please refer to your programming tool documentation for further information.
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CHAPTER 5

Debugging Your Design

This chapter shows you how to debug the tutorial design you instrumented
earlier. To proceed with debugging, your design must be synthesized, run
through place and route, and programmed into the FPGA device. Also, the
device must be connected to the host machine using the proper cable and pin
connections.

The debugging process consists of setting up the debugging environment,
enabling triggers in the IICE, and examining the data downloaded from your
hardware. The debug flow is:

* Launching the Identify Debugger
* Specifying the JTAG Cable
* Setting Up Triggers and Capturing Data

* Generating Waveforms
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Launching the Identify Debugger

You can launch the Identify debugger directly from the Synplify Pro synthesis
tool or you can open the Identify debugger from the GUI and then use the
Identify debugger Open Project File dialog box to open your synthesis project.
Launching the debugger from the Synplify Pro synthesis tool simplifies the
procedure by using the currently active Identify implementation.

To launch the Identify debugger from the Synplify Pro synthesis tool:

1. Open the identify_bus_demo project in the Synplify Pro synthesis tool and
highlight the Identify implementation in the Project view.

2. With the right mouse button, select Launch Identify Debugger from the
popup menu or click the Launch Identify Debugger icon in the top menu
bar.

Project Files _
|identify_bus_demo : rev_2 (work.bus_demo) - Microsemi IGLOO+ : AGLPO30V2 : C5201:
= @ [identify_bus_demo] - C:\designs\dentify_bus_demaolidentify_bus_demo.prj
B[ vHOL
B[ Logic Constraints (5DC)
-- ) par Options
L rev 1

C ] B pr 1 - Xilime PES

Implementation Options. ..
Change Implementation Mame...
Hierarchical Project Options. ..
Add Subproject Implementations

Copy Implementation. ..

Remove Implementation. .. DEL
New Identify Implementation...
Launch Identify Instrumentor

H

Launch Idt%ﬁfy Debugger

RTL View

Technology View

Add Place &Route...

Run F&

Project View Options...

3. When prompted to save your project changes, click OK to launch the
Identify debugger.
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Launching the Identify debugger from the Synplify Pro synthesis tool:
e Brings up the Identify debugger graphical interface.

¢ Displays the design hierarchy and the HDL file content with the previ-
ously instrumented watchpoints and breakpoints visible.

Only the instrumentation that you entered previously with the Identify
instrumentor is displayed in the Identify debugger.

Specifying the JTAG Cable

The type of cable used to communicate with the FPGA must be specified so
that the correct protocol is used to communicate with the physical device.
The JTAG cable and cable port are set in the Communication settings section of
the project window after the project is read in. To restore this window, click
the identify_bus_demo tab at the bottom of the window.

The hardware used to develop this tutorial used a flashPro USB cable — your
cable type may differ. The Microsemi_BUuiltinJTAG setting enables you to use any
of the flashPro cables.

@ =
‘ Sample Mode: m Cross rigger mode; IW’ ‘ @
— Communication settings \
Fun Cable type: [Microsem_BullindTAG =]
M IICE Port zettings ... | Show chain ... |

¥ IICE_0 Cormm check ... |

N

— Instrumentation settingz

Device family: igloopluz
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After completing the computer-to-board cable interface, use the com check
command to verify that the JTAG cable is connected properly and that the
Identify debugger recognizes the instrumented design in the JTAG chain. For

more information, see Chapter 9, Connecting to the Target System, in the User
Guide.
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Setting Up Triggers and Capturing Data

Trigger operations include:
* Triggering on a Watchpoint
* Triggering on a Breakpoint
* Using the Complex Counter

* Cross Triggering

Triggering on a Watchpoint

A watchpoint trigger can be specified on any sampled signal. The Watchpoint
Setup dialog box contains a full HDL parser so that any legal VHDL or Verilog
expression that evaluates to a constant can be used. When the signal with
the watchpoint trigger changes to the value of the watchpoint expression, the
Identify debugger triggers.

To set a simple watchpoint:

1. Select IICE unit lICE, expand the beh icon, and click on arb_inst (arbiter) to
update the instrumentation window with the arbiter entity.

2. Click on curr_state signal on line 46 and select Set trigger expressions from
the popup menu.

3. In the first value field, enter st idlel, and leave the second field blank.

45 type states iz ( st_idlel, st_idlel, st_grantl, st_grant2);

a5 signal écurr state, d@next state: states;

47 signal reqgl, reg2, regll, reqg22, grantll, grant22 : std logic;
== Watchpoint Setup x|

49 be

- Setup the first walue only to watch a valug in a patters tree on signal "'curr_state”
=0 or both values bo watch a transition from the firgt to the second in a pattern tree;

. | |
; : ok I LCancel |

55 elsif Oclk'event and o«:lk = '1' then
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4. Click OK to close the Watchpoint Setup dialog box. The color of the curr_state
watchpoint icon changes from green to red to indicate that it is active.

5. Redisplay the project view (click the identify_bus_demo tab) and uncheck
the IICE_O selection under the Run button.

¥ IICE
( [~ IICE_D )

6. Click the Run button to arm the IICE on the FPGA device.

7. When the trigger occurs, the sampled data is transferred back to the
debugger (the icon in the IICE tab changes to a green check mark
coincident with the trigger). Click the IICE tab to redisplay the
instrumentation window. The sampled data is displayed in the source
code display next to the sampled signals. Notice that the values in yellow
adjacent to the sampled signals are the data sampled from the FPGA.

g3 process | $€curr staceSt_idlel  req1il, req22 )

85 grantll <= '0';

86 grant2z <= '0';

case (#curr stateSt_idlely ;o

g9 when st_idlel =>

- 90 if ( reqll = '"1' ) and ( req22 = '1' )} then
@ g1 depext_stareSt_Orantl <= st granti;
g2 elsif { reqll = '1' )} then
@ 93 dnext_stateSt_OTARTLl o= =t grantl:
94 elsif [ req22 = '1' ) then
@ g5 denext_stareSt_Orantl <= st granti;
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8. This step uses a waveform viewer. The tutorial was developed on a
Windows platform that used the GTKWave viewer. Open the Debugger
Preferences dialog box (select Options-> Debugger preferences) and make sure
that the GTKWave radio button is selected. Be sure to click OK if it was
necessary to change the setting.

x

r— Default wavetorm Wiewer

T Aldec Active-HDL

" Movas Debussy

" Synopsys DVE

i GTKwWave

" Model Technology ModelSim

9. Click the Open Waveform Display icon to open the waveform viewer. The
waveform shows the extra debugger signals (identify_cycle and
identify_sampleclock) and the watchpointed signals. In the waveform
diagram, the partial bus waveforms are displayed as separate entries;
the display is divided evenly between events before and after the trigger
point (the red center line in the diagram).

Signals Waves

Time . 40386 ns
s = g i
identify sampleclock=

curr state[71:0] =

St_grant st_idlel St_grantz £

next_state[71:0] =: st_idlel
grantl =i
wb_adr o[3:2] =

wb_adr o[7:3] =

10. Close the GTKWave waveform viewer.
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11. From the hierarchy browser, click block xfer_inst (block_xfer) to view the
partially instrumented wb_adr_o bus. The values of the instrumented
segments of the bus (bits 7 through 5 and bits 3 and 2) are displayed,
while the uninstrumented bits are displayed as question marks (?) to
represent an unknown value.

port |
FPub adr o?700121022, ou¢ std logic vector (addr width-1 downta 0) := { o
wb_dat i: in std logic wvector (data width-1 downto 0) := ( others => '0Q'
wb_dat o: out std logic wvector (data width-1 downto Q) := ( others => 'Q'
wb_cyc o: out std logic:

12. Change the trigger position from middle to early using the early,
trigger-position button on the left.

= B =

Early Middle Late

13. Select Debug->Run from the menu or click the Arm selected IICE(s) for
triggering icon (the running man icon in the menu bar) to generate a new
trigger.

14. Open the waveform viewer. The sample time remains unchanged, but
the position of the entire waveform shifts so that ninety percent of the
samples are visible prior to the trigger (the red line) and ten percent are
visible following the trigger.

Triggering on a Breakpoint

The next sequence switches from watchpoint triggering to simple breakpoint
triggering. To setup a breakpoint in the arbiter:

1. Close the waveform viewer if you have not already done so.

2. In the hierarchy browser, click arb_inst (arbiter) to redisplay the arbiter in
the instrumentation window.

3. Click the curr_state signal and select Watch from the popup menu to toggle
the watchpoint off. The lens changes from red to green indicating that
you have deactivated the watchpoint trigger.
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4. Click on the green breakpoint button below the case statement on line
90. The icon turns red to indicate that the breakpoint has been
activated. This breakpoint is set to trigger when the curr_state signal has
the value st_idlel on the positive edge of the sample clock. Other
breakpoint buttons can also be used for the breakpoint.

case (éWcourr stateSt_idlely ;g

29 when st _idlel =>

- =14 if ( reqgll = '1' ) and (| reg22 = '1l' } then
@ fornexr staceSt_grantl .= st_grant2;
elsif { reqll = '1' } then
@ fenext stateSt_grantl .= st_grantl;
elsif { reg22 = '1' } then
" ] a5 é¥next stateSt_grantl .= st _grant2;
96 else
@ 97 denext staceSt_grantl .= st_idlel:
end if:

5. Now that you have an active trigger condition, arm the IICE trigger
circuits by doing one of the following:

— Clicking the Arm selected IICE(s) for triggering (running man) icon in the
menu bar

— Selecting Debug->Run from the top menu

— Redisplaying the project window and then clicking the large Run
button

Note: Using the Run button in the project window allows you to indi-
vidually select multiple IICE units (necessary when performing
cross triggering); the menu selections only arm the active IICE.

The IICE now waits for the trigger to occur. When the trigger occurs, the
sampled data is transferred back to the debugger where it is displayed in the
source code display next to the sampled signals as shown in the following
figure.
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aa caze (f¥curr state=t_1dlely o
a4 when =t_idlel =:
+ @ a0 if  regll = '1' ) and { regi22 = '1'
] 91 donext stateSt_1dlel .= =t grant?;
92 elzif { regll = '1l' ) then
"] 93 dnext statest_1dlel ¢- ot grantl:
94 elzif { regid = 'l' ) then
"] a5 dnext stateSt_1dlel ¢= ot grant?:
el else
"] 97 donext statesSt_idlel (= =t idlel:
EE end 1if:
99 when =t_idle? =»
100 if § regll = '1' ) and { reg22 = '1'
101 dnext statest_1dlel = ot grantl:

1 then

1 then

The values in yellow adjacent to the sampled signals are the data sampled
from the FPGA (st_idlel). Also, the small arrow to the left of the breakpoint
icon on line 90 indicates that this is the breakpoint that triggered (identifying
which breakpoint triggered is important when multiple breakpoints are

active).

You can check for active and inactive watchpoints and breakpoints by
clicking the appropriate show enabled/disabled icon in the menu bar.

Clicking the show enabled breakpoints icon shows the single enabled breakpoint

on line 90 for the corresponding process/case.

Identify Debugger: Find Design Elements 101 =l
Of type: I break point j
Mamed:
wiith statuz Ienabled j
Look in: 4
In lICE: IICE
[ Show hidden elements Find | Claze |
I @ arb.vhd: 90 /beh/arb_inst/beh/process_83/case 88/arb.vhd: 30 PJ
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As with watchpoint triggering, you can change where the trigger point is in
the buffer by selecting one of the Early, Middle, or Late icons and again arming
the IICE. The trigger location changes the next time the IICE triggers.

The Cycle display in the middle of the menu bar shows the value zero. This is
the point in the sample data buffer where the trigger occurred. By clicking on
the up-down arrows on the right, you can increase or decrease the cycle
count to display the data values before and after the trigger point.

. lfdEa
‘ I:_I,I-:IE.I-'I 3' ‘

Using the Complex Counter

The tutorial design is instrumented using a 16-bit complex counter. Up to
this point, the design has been debugged without using the counter. The
counter is disabled by setting the counter mode to events (the default) and
setting the counter value to 1.

There are four, complex counter operating modes:
e cycles — triggers on value n number of clock cycles after the condition.
* events — triggers on the nth iteration of a trigger condition.
* pulsewidth — triggers when the condition has been active for n clock cycles.

» watchdog — triggers when the condition has been inactive for n clock
cycles.

For this portion of the tutorial, the complex counter remains in the events
mode and uses a large counter value to step through individual debug events.
To use the complex counter:

1. Deactivate the previously set breakpoint at line 90.

2. Click on the curr_state watchpoint and select Set trigger expression from the
popup menu.

3. Enter st_grant2 in the left box (replacing st_idlel) and click OK.

4. Enter 10000 in the Value field to the right of the Complex Counter Mode
field.
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Identify Debugger - [C:fdesigns/bus_demol /bus_demo)

File Edit Debug Options Window Help

S|+ o BHEE [ JE
Comples Counter Mode:levents j‘ Yalue: [10000 ) |

S. Select Debug->Run from the menu or click the Arm selected IICE(s) for
triggering (running man) icon to arm the IICE. Note that this run takes a
little longer to trigger as it must wait for the 10,000th event (st_grant2) to
occur.

6. Set the Complex Counter Mode to cycles and enter 3 in the Value field as
shown in the following figure.

Identify Debugger - [C:fdesignsfidentify_bus_demo/bus

File Edit Debug Options Window Help

2|1 0| SEE] - o

Comples Counter Mod(lcycles j Value:|3 ) |

7. Click on the curr_state signal and select Set trigger expression. Enter st_idlel
in the left field and st_grant2 in the right field of the Watchpoint Setup dialog
box.

8. Select Debug->Run from the menu or click the Arm selected IICE(s) for
triggering icon to arm the trigger.

9. View the resulting waveform and verify that the trigger occurs three
cycles after the curr_state signal transitions from st idlel to st grant2.

Signals

Time

identify cycle[31:0] =

identify sampleclock=
curr_ state[71:0] =
next state[71:0] =
grantl =I

wh_adr_o[3:2] =
wh_adr_o[7:5] =I
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10. Close the viewer.
11. Set the Complex Counter Mode to pulsewidth.
12. Set the counter Value to 5.

13. Click curr_state, select Set Trigger Expression, and enter st idlel in the left
field; leave the right field blank and click OK.

14. Select Debug->Run from the menu or click the Arm selected IICE(s) for
triggering icon to arm the trigger.

15. View the resulting waveform and note that the trigger occurs on the fifth
rising clock edge after the curr_state signal transitions to st_idlel.

Signals Waves

Time

identify cycle[31:0] =

identify sampleclock=
curr_state[71:0] =:
next_state[71:0] =:
grantl =

wh_adr_of[3:2] =
wh_adr_a[7:5] =

16. Close the waveform viewer.

Cross Triggering

Cross triggering (triggering between two IICE units to debug logic across clock
domains) is described in this section. The design used with the development
of this tutorial has two clock oscillators, a 33 MHz oscillator and a 50 MHz
oscillator. Signals between the arbiter and the other logic are synchronized in
the design with these clocks.

For this section of the tutorial, you will use IICE_0 which you previously
instrumented in the block_xfer module and which is clocked by the 50 MHz
oscillator as a trigger for the first IICE unit (IICE). This first IICE unit was
instrumented in the arbiter module and is being clocked by the 33 MHz clock.
When the arbiter sees the request from the block_xfer module, it changes to
state st_grant2 to process the request. Triggering the IICE module occurs when
IICE_O triggers on the request and the state changes.
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To demonstrate cross triggering between clock domains:

1.

Select the lICE (left) tab and set the Cross trigger mode to trigger on
after-1ICE_O.

Crozs trigger mode; Iafter-IIEE_EI

dizabled
any
all

after-al

If the drop-down menu is blank, the Allow cross-triggering in ICE checkbox
on the IICE Controller tab for IICE unit IICE has not been checked in the
Identify instrumentor and you must go back to the Identify instrumentor
and enable the checkbox. Click File->Save activations to save your current
settings before exiting the Identify debugger

Set the Complex Counter Mode back to events and enter 1 in the Value field.

Eq H | % |%| E}lcle:ID }: |

Comples Counter Mode:levents j Yalue: [1 |

. Click on the curr_state signal on line 46 and set the trigger expression to

st_grant2, and click OK.

Watchpoint Setup x|

Setup the first walue only to watch a valug in a patters tree on signal "'curr_state”
or both values bo watch a transition from the firgt to the second in a pattern tree;

|st_grant? |

ok I LCancel |

Click on the IICE_O tab and verify that the Cross trigger mode is set to
disabled.

In the hierarchy window, expand the beh block and select blk_xfer_inst
(block_xfer).

In the instrumentation window for IICE_O, click on wb_cyc_0 on line 38
and select Set trigger expressions from the popup menu to display the
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Watchpoint Setup dialog box. Enter ‘1’ (with the single quote marks) in the
first field and click OK; the watchpoint icon turns red to indicate that it
is enabled.

Watchpoint Setup x|

Setup the first walue onlp o watch a value in a pattern tree on zignal "whb_cyc_o"
or both values to watch a tranzition from the first to the secand in a pattern tree:

' |

ak. LCancel |

7. Open the project window by clicking the identify_bus_demo tab. Select the
Run button to arm the two IICE modules. [ICE_O triggers itself when the
request is active and also triggers the first IICE unit (IICE). When this
IICE triggers, the run is complete.

Note: Using the Run button in the project window allows you to indi-
vidually select multiple IICE units (necessary when performing
cross triggering); the menu selections only arm the active IICE.

8. Click the IICE tab and note that the run has completed and that values
are annotated in the code.

g édgrantl'l' : out std logic:
3g gwgrant? : out std logic

40 b

47 end arbiter;

43 architecture beh of arbiter i=

44 type states is ( st_idlel, st idle2, =t _grantl, st _grantl):

45 signal éWcurr stateSt _OTrantl dypnext stateST_OTANT2; ztates;

9. Advance and retard the cycle count using the up and down buttons to
see the values of the instrumented signals change.

10. Close the debugger. The lab is complete.
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Generating Waveforms

The data captured from the design can be displayed as waveform data by
using a waveform viewer. Viewer setup is controlled by the Debugger Prefer-
ences dialog box. Selecting Options->Debugger preferences from the menu bar
brings up the dialog box shown below.

Debugger Preferences ﬂ

— Default W aveform Yiewer
 Aldec Active-HDL
 Movas Debussy
% Synopsys DVE
 GTEWave
= Model Technalagy MaodelSim

' Custom Procedure

|cust0m_wavefnlmviewer

— ' avetorm Display

Perind [nz): I 20 j‘ Set Diefault |

[ Show equivalent signals in wavebarm

— Activation settings

¥ Auto-save tigger settings and sample results

oK Cancel

The Period field sets the period for the waveform display and is independent of
the design speed.

After running the Identify debugger, the waveform viewer is displayed by
selecting Window->Waveform from the menu or by clicking the Open Waveform
Display icon in the menu bar.

All sampled signals in the design are included in the waveform display. Two
additional signals are automatically added to the top of the display. The first
signal, identify_cycle, reflects the trigger location in the sample buffer. The

second signal, identify_sampleclock, is a reference that shows every clock edge.
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